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U.S. Government Required Disclaimer - Commodity Futures Trading Commission Futures and Options
trading has large potential rewards, but also large potential risk. You must be aware of the risks and
be willing to accept them in order to invest in the futures and options markets. Don't trade with
money you can't afford to lose. This is neither a solicitation nor an offer to Buy/Sell futures or options.
No representation is being made that any account will or is likely to achieve profits or losses similar to
those discussed on this web site. The past performance of any trading system or methodology is not
necessarily indicative of future results.

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN
LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT
ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE
UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH AS
LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT
THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING MADE
THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN.

No representation is being made that any account will or is likely to achieve profits or losses similar to
those shown. In fact, there are frequently sharp differences between hypothetical performance
results and the actual results subsequently achieved by any particular trading program. Hypothetical
trading does not involve financial risk, and no hypothetical trading record can completely account for
the impact of financial risk in actual trading.

All information on this website or any product purchased from this website is for educational
purposes only and is not intended to provide financial advise. Any statements about profits or income,
expressed or implied, does not represent a guarantee. Your actual trading may result in losses as no
trading system is guaranteed. You accept full responsibilities for your actions, trades, profit or loss,
and agree to hold Simple4XSystem and any authorized distributors of this information harmless in any
and all ways.

*Depending upon state and country laws--always seek professional advice



PART ONE—INSTALLING AUTOSCALERPv3.EX4
INTO YOUR MT4 PLATFORM

Follow these steps to copy and paste AutoScaler into your platform.

1. Open your platform and click on the File tab in the upper left hand corner.

2. Scroll down to the “Open Data Folders” option in the window which opened. Click on this option to
open a new window.

3. In the new window that opens, locate and double click on the MQL4 folder to open it. Alternatively
you can right click on the MQL4 folder and select Open to open the folder.

4. Inside the MQL4 folder locate and open the Experts folder.

5. Copy and paste AutoScalerPv3.ex4 into this Experts folder.

6. Now close all the open windows.

7. Reopen the platform and click on the View tab in the upper left hand corner.

8. Select Navigator from the open window to open the Navigator window.

9. Inside the Navigator window locate the Experts folder and click on it to open it.

10. Right click your mouse inside the Experts area and select Refresh. This will complete the loading
process to add AutoScalerPv3 into your platform

11. Locate the AutoScalerPv3.ex4 file and left click on the file, holding the left mouse button down,
and drag the file onto your chart.

12. Make sure there are check marks next to Allow Live Trading, Enable Alerts, and Allow DLL imports
under the Common tab.

13. Adjust the various settings under the Inputs tab according to your preferences.

14. Now click the OK button along the bottom right portion of the AutoScalerPv1 window.

15. Make sure the AutoTrading button along the top of the platform is on (green light = on, red light =
off). If the light is red, click on the AutoTrading box once to turn this function on.

16. Check the left hand corner of the chart where you loaded the AutoScalerPv1 EA. If you see a
Smiley Face, then the EA has been loaded properly and is now ready to use.

17. If you don’t see a smiley face, go back through every single one of these steps to make sure you
installed and loaded the EA according to the instructions.

18. If you performed the install correctly but still do not see the Smiley Face, click on the Tools tab
along the top of your platform and select Options.

19. Inside the Options window, click on the Expert Advisors tab and make sure there is a check mark
in the boxes next to Allow automated trading and Allow DLL imports.

20. You should see the Smiley face now. If not, contact me at jeffglenellis@gmail.com and I will
schedule a remote viewing session to see if we can spot where the error lies.



PART TWO—ADJUSTING THE SETTINGS FOR AUTOSCALER-Pv3

After you install Forex AutoScalerPv3 onto an MT4 chart, when you click on the Inputs tab you will see
these settings:

Here is a list and detailed explanation for what each of these settings does within the AutoScalerPv1
EA. Please study this carefully because some of the settings must remain set at 0.0 when other
settings carry a positive number.

BUY Trade Types: This is a dropdown option to make you trades either Stop or Limit trades. If you
don’t know the difference between the two, leave it on Stop.

BUY Price: Here you type in the exact price you want to use for your first Buy trade (the Manual
trade). Price must be higher than current price or the platform will reject the trade (unless you are
setting up Limit trades, in which case the Buy price must be LOWER than the current price). NOTE: If
you set a positive number for the Buy price, DO NOT INSERT A NUMBER FOR BUY Pips From Current
Ask Price. Use one or the other, but not both.



BUY Pips from Current Ask Price: Here you can type in the number of pips away from current price
you want to take the first (Manual) trade. The example above displays a setting of 3000, which is a
$30 price move on the US30, which is where this example was taken from. For Currency Pairs and
other tradable items offered by your broker, this number will likely be substantially lower. NOTE: If
you set a positive number for Buy Pips From Current Ask Price, DO NOT INSERT A NUMBER FOR BUY
Price. Use one or the other, but not both.

SELL Trade Types: A dropdown box allowing you to choose Stop or Limit trades. If you do not know
the difference, stay with Stop trades.

SELL Price: Here you type in the exact price you want to use for your first Sell trade (the Manual
trade). Price must be lower than current price or the platform will reject the trade (unless you are
setting up Limit trades, in which case the Sell price must be HIGHER than the current price). NOTE: If
you set a positive number for the Sell price, DO NOT INSERT A NUMBER FOR SELL Pips From Current
Bid Price. Use one or the other, but not both.

MagicNumber: Required by the programming language, each EA will have its own Magic Number.
Leave this setting alone. You will likely never have any reason to change it.

Lot: Here is where you set Lot Sizes for your AutoScalerPv3 Trades. 1.0 = 1 Full Lot. 0.1 = 1 Mini Lot.
0.01 = 1 Micro Lot. Check with your broker to see that they allow Micro Lots. Some do, some don’t. If
you set this option as a Micro Lot and your broker does not allow Micro Lot trading, AutoScaler will
not set up any trades for you.

Lot Multiplier: This function will increase the Lot Size of your pending trades by whatever amount
you set. I STRONGLY RECOMMEND YOU LEAVE THIS SET AT 1 UNTIL YOU ARE COMFORTABLE USING
AUTOSCALER. Setting it any higher than 1 will cause your lot size to increase for each pending trade
you place. So a single minilot manual trade taken with Lot Multiplier set at 2 would result in a 2
minilot first pending trade, a 4 minilot second pending trade, an 8 minilot third pending trade, and so
on. You can quickly eat up all your available margin funds if you set this to 2. So leave it at 1 for now.

AdditionalTrades: You can scale in anywhere from 1 to 30 additional trades on top of the manual
trade you must take in order for AutoScalerPv1 to work. However many trades you want, type in that
number (30 is the maximum, though). HOWEVER, if you want to set up straddle trades going in both
directions (hedging) you can do so in segments of 10, as long as your broker allows hedging (sorry
USA, none of your brokers allow that).

PipsInterval: This is how many pips apart each pending AutoScalerPv3 trade will be set up. If you want
5 pips between trades, type in 5. If you want 10, type in 10. If you are trading Gold, pips are worth 10
cents apiece (a $1 move in the price of gold equals 10 pips). So if you want a 5 pip space between
trades, you need to type in 50. A 10 pip gap would require a setting of 100. If you are trading Indices
such as the US30 or NAS or S&P, you will need to add two zeros to your desired box size, using $1
increments. In other words, if you want to space your trades $5 apart, you would use a setting of 500
UNLESS your broker has eliminated the numbers after the decimal point, in which case you would go
back to a setting of 5. EXAMPLE: Price = 35000.50, setting = 500. Price = 35000, setting = 5.

FollowManualTradeTP and FollowManualTradeSL: TP stands for Take Profit, SL stands for Stop Loss.
Both of these options work exactly the same way. If you want to set a specific price for your Manually
placed trade to exit at either or both the TP and SL, AND you want all of your pending AutoScalerPv3
trades to exit at the exact same price, you need to switch the settings on these two options to True.
Double click on the window next to TP and/or SL to activate the window. Click on the downward
facing arrow in the right corner of the window to open a drop-down box. Click on True to activate this
option, click on False to terminate this option.

TakeProfit(manual) and StopLoss(manual): Both of these options work the same way. If you want to
automatically set a Take Profit price and/or a Stop Loss price on your manually placed trade without



needing to go back into the MT4 system and manually set these options, simply type in the number of
pips you want for a Take Profit and/or a Stop Loss. If you want a 20 pip TP or SL, type in 20. If you
want a 100 pip TP and/or SL, type in 100 (keeping in mind Gold and the Indices need the extra zero
(Gold) or two (Indices). This will automatically place the TP and/or SL on your manual trade. NOTE: If
you set the Follow Manual Trade TP or SL settings to true, then the price point equal to the pip value
you set here will be used for all your AutoScaler trades. So if you set a TP to 20 and when you place
your manual trade, price is at 1.2000, it will set your manual TP at 1.2020 AND set the same TP price
for all your AutoScalerPv3 trades. (The same rules for trading Gold and trading Indices applies. You
will need to add 1 zero [gold] or 2 zeros [Indices] to see the results you seek in pricing your SL and/or
TP). NOTE: If you adjust these two settings to a positive integer, you must leave the (grid) settings,
below, set to ZERO.

TakeProfit(grid) and StopLoss(grid): If you want to set a fixed number of pips for your Take Profit
and/or Stop Loss on all your pending AutoScalerPv3 trades, type in that pip number here. If you want
a 20 pip TP on all your AutoScalerPv3 trades, type in 20 in the TakeProfit(grid) line. If you want a 20
pip SL, type in 20 in the section next to StopLoss(grid). Note: If you use either or both of these options,
you must leave the corresponding FollowManualTrade option set to False. If you set the Follow option
to True and then set a positive number for the Grid, it creates a conflict within the EA and it will not
function. So either use the Follow option or the Grid option for TP and SL, but not both. (Same rules
apply to Gold and Indices as noted above). NOTE: If you adjust these two settings to a positive integer,
you must leave the (manual) settings, above, set to ZERO.

SL Risk%: For those of you who want to use a Stop Loss equal to x% of your account, use this
option and leave the FollowManualTradeSL option false and the StopLoss(manual) and StopLoss(grid)
option set at 0.0. For a full percentage point value, such a 2%, simply type in 2.0. For a portion of a
single percent, such as half, or one quarter, type that in as well as follows: ¼% = .25; ½% = .50;
¾%=.75; 1% = 1.0; and so on.

Trailing Stop: As advertised, this is a trailing stop function. Type in whatever pip number you
want to use as a trailing stop and the EA will turn the trail on once price reaches that figure. It will use
your preset SL amount from either (manual) or (grid) as the starting point for the trail.

Breakeven Lock: Basic breakeven does not exactly mean true breakeven. Most of us have
commissions or other fees we owe every time we take a trade. So figure out how many extra pips
you need to earn in order to pay off all those extra fees and add that number to this setting. Usually 2
or 3 will be more than enough but it depends on your broker. After that, whenever you hit the Move
Stop to B/E, the platform will move your stop to breakeven plus the extra 2 or 3 pips you added in
with this setting, making your trade a truly breakeven event.

Slippage: This sets up the amount of pips you are willing to sacrifice to get into a trade if entry
cannot be made at your specified price point. I strongly suggest you leave it at 2 unless you have a
very good reason to change it.

Incremental SL. This is the overall size of your desired stop loss. I use a 12 pip stop on most of my
trades, so for FX the stop is 12, for Gold 120 and for Indices 1200. IMPORTANT: You MUST set the
StopLoss(Manual) setting to the same number when using the Incremental SL. If you do not want to
use the Incremental SL, set it to Zero.

Incremental SL Step: The amount the Stop Loss will move each time the Step Stop is activated. In
most of my trading I use a 5 pip step, so my setting for Currencies is 5, for Gold 50 and for Indices 500.
If you do not want to use this feature, set it to Zero.

Display Corner: This is how you move the Buy/Sell buttons around. You can adjust them to appear
in any of the four corners of the chart: Upper Left, Upper Right, Lower Left or Lower Right, To see all
of these options demonstrated live, view the accompanying videos found on the download
page. Once you have adjusted the Inputs to your liking, click the OK button and AutoScalerPv3 will
load onto your chart and be available for your next trade.



USING THE CHART BUTTONS

These are pretty self-explanatory, but history has taught me there really is no such thing, so here is
how to use the Chart Buttons with AutoScaler-Pv3

STRADDLE: Clicking this button will set up both your Pending Buy and your Pending Sell trades at the
same time. This allows you to set up a straddle without needing to hit the Buy and Sell buttons
individually.

SELL: Click this button to set up your Pending Sell trade(s) according to the parameters you set up
inside the Inputs.

BUY: Click this button to set up your Pending Buy trade according to the parameters you set up inside
the Inputs.

CLOSE HALF SELL: Click this button if you have an even number of Sell trades open and you wish to
close half of them with the balance remaining open and your Stop Loss moved to Break Even. You
must have a Stop Loss set up inside the Stop Loss (grid) input for this to work.

CLOSE HALF BUY: Click this button if you have an even number of Buy trades open and you wish to
close half of them with the balance remaining open and your Stop Loss moved to Break Even. You
must have a Stop Loss set up inside the Stop Loss (grid) input for this to work.

MOVE SL to BE: Move your stop loss to break even. Works best when you are using a separate Stop
Loss for each trade.

CLOSE ALL SELL: Click this button to close all Open and Pending SELL trades

CLOSE ALL BUY: Click this button to close all Open and Pending BUY trades.



TROUBLESHOOTING

If you followed all the steps as outlined above and AutoScalerPv3 does not place any additional trades
once your manual trade is accepted by your platform/broker, her are the most common reasons why
and how to fix them.

1. Open the Inputs window and look under the common tab to make sure Enable Alerts, Allow Live
Trading, and Allow DLL imports all have check-marks next to them.

2. Make sure the AutoTrading button along the top of your toolbar is On. If so it should look like this:

3. Make certain you have enough funds in your account to cover the margin costs for all your trades.
This includes Demo accounts as well. If you do not have enough funds to cover the trades, your
platform will reject the trades. The simplest fix is to reduce your trade size from Full Lot (1.0) to Mini
Lots (0.1) or from Mini Lots to Micro Lots (0.01).

4. Make sure your PipsInterval setting is not too small. Some brokers reject trades if they are placed
within 1 or 2 pips of the previous trade. Experiment with your broker’s platform to see if you are
limited in this way. Or stick with a minimum of 3 pips for this setting. I’ve never heard of a broker
rejecting trades 3 pips apart for being too close.

5. If you have AutoScalerPv3 loaded onto 2 or more charts for the same pair/trading vehicle, this will
cause chaos within your platform and you will not get the results you are looking for. So do not load
AutoScalerPv3 onto a 1M and a 5M chart for the same pair or Indices/Gold chart. Only load it once
per trading instrument.

6. If you are a Renko trader, we can no longer run AutoScalerPv3 on Renko charts. Load it onto a
timed chart and take your trades from there. The lines will all still appear on your Renko chart but
recent changes to the MT4 platform have stopped AutoScaler from working on Renko. We will keep
monitoring the situation and alert everyone if/when that changes.

7. Occasionally someone comes up with a new and unique way to screw up the works, and when this
happens, and none of the previous Troubleshooting steps apply, open the Terminal Window and click
on the Experts tab along the bottom of Terminal. You should see an Error Code number next to the
aborted AutoScaler trade. Look the number up using a Google search “What does MT4 Error Code ---
mean” where “---” is replaced by the actual Error Code. You’ll find an answer. If not, send the Error
Code number to me at jeffglenellis@gmail.com and I will sort it out for you.


